Percussion Documentation Table of Contents

Intro to the Percussion Interface ........................................................................................................ 2
  Logging In to Percussion .................................................................................................................. 2
  The Dashboard ............................................................................................................................... 2
    Managing Dashboard Gadgets ...................................................................................................... 3
  The Menu ......................................................................................................................................... 4
  The Finder ....................................................................................................................................... 4
  Editor view ..................................................................................................................................... 6
    Content Tab ................................................................................................................................. 7

Working with pages .......................................................................................................................... 8
  Modifying Content Through a Widget Editor .................................................................................. 8
  Previewing a Page .......................................................................................................................... 9
  Viewing and Editing Page Metadata ............................................................................................. 10
  How to Add a Collapsible/Expandable Box .................................................................................. 10
  Workflow Comments ..................................................................................................................... 12
  Working with Page Revisions .......................................................................................................... 13
  Approvals and Pages by Status ....................................................................................................... 15

Working With Assets ......................................................................................................................... 18
  Uploading Assets ............................................................................................................................ 18
  Publishing Assets ........................................................................................................................... 19
  Bulk Uploading Assets .................................................................................................................... 20
  Deleting Assets ............................................................................................................................... 21
  Putting an Asset Onto Your Page ..................................................................................................... 21
  Banners ......................................................................................................................................... 22

Forms ................................................................................................................................................ 23

News and Events ............................................................................................................................... 23

All questions regarding Percussion CMS training should be directed to your Account Manager.
Introduction to the Percussion Interface

Logging in to Percussion

To log in to Percussion, which is the interface used to manage Oakland.edu, follow these steps:

1. Enter "percussion.oakland.edu" into the web browser of your choice
   a. Preferred web browsers are Firefox and Google Chrome, you may experience issues when using other browsers
2. When the browser loads the page you’ll be prompted to enter your Oakland net ID and Password as follows:
   
   ![Percussion Login Screen]

   
3. Press the [Log In] button to submit your net ID and Password
4. If you cannot remember your net ID or password or would like to reset it, visit "netid.oakland.edu" and choose from either “Change your NetID password” or “Obtain your NetID account or reset your NetID password”
5. Once you have successfully logged in, you will be taken to the Percussion dashboard

The Dashboard

When you initially log in to Percussion, the Dashboard (the default view) presents you with useful information, such as lists of pages on sections that you are monitoring and links to Percussion resources. Specific information and links are shown in gadgets, the small boxes of data in the graphic below.

![Percussion Dashboard]

The first time you log in to Percussion, it displays the default Dashboard as seen in the graphic to the left.

The default Dashboard includes the following default gadgets:

- Welcome
- Pages by Status (Pending, All Sites)
- License Monitor

The Dashboard is unique to each user and can be arranged based on your selection of gadgets.
Managing Dashboard Gadgets

Gadgets are essentially Applications that can be added to each individual user's dashboard based upon their own preference.

To add a gadget to the Dashboard:

1. In the Dashboard toolbar, click Add Dashboard Gadgets located below the Finder and all the way to the left of the page.

2. Click on the icon of the gadget you want to add to the Dashboard, drag it to the location where you want to add it. When you drag the gadget icon over a valid drop location, the location will be highlighted green. Drop the icon on a valid location to add the gadget to that location.

3. Optionally, configure the gadget after it is placed by clicking on the drop arrow located in the upper right corner of the gadget.

Deleting Gadgets

To delete a gadget from the Dashboard, click on the drop arrow in the upper right corner of the gadget and from the drop menu, choose Delete. The gadget is deleted from the Dashboard. When you delete a gadget from the Dashboard, all configurations of that gadget are deleted as well.

Moving Gadgets

To move a gadget to a different location on the Dashboard, click on the gadget title bar and drag it to the new location. When you drag the gadget over a valid drop location, the location will be highlighted green. Drop the gadget on a valid location to move it to that location.

Resetting the Dashboard

When you reset the Dashboard, you return to the default Dashboard (see above graphic). Any gadgets you have added to the Dashboard are removed and their configurations are deleted. Default gadgets are returned to their default location and configurations restored to default settings.

To reset the Dashboard:

1. Click Reset on the right side of the Dashboard toolbar.
   CM1 will then display a warning dialog.
2. Click [Yes] to reset the Dashboard. Click [No] to stop the reset.
The Menu

The menu is located in the upper left hand corner, directly to the right of the “P” Percussion logo. In the graphic to the left, an expanded menu displays all of its options:

Use the **Dashboard** option to see lists of pages on sections that you are monitoring and links to Percussion resources.

Use the **Editor** option to create content for your website.

The Finder

The upper panel in Percussion is called the Finder. The Finder allows you to interact with the file structure of your section within Percussion. Use the Finder to navigate to content within your section.

If you click Assets to the far left of the Finder, the columns display the assets in your system. If you click Site, the columns display the sections and pages in the Oakland website.

*Note: Pages are complete website pages; assets are pieces of content that you can include on pages.*

Finding and Selecting Elements in the Finder

The Finder contains folders and sites that store other folders and pages or assets. When you click Assets, Sites, a site, a folder, or a section folder, the next column opens and displays its contents. You can locate a folder or item by following the item’s folder path in the columns.

The final element in each path is a page. In the graphic above, the selected path is: **Sites > oakland.edu (site) > ucm (section folder) > logos-marks-and-fonts (section folder) > logo-and-colors (section folder) > index (page).**

Search

The Finder navigation bar allows you to navigate by entering in a path to a page or asset in the system. It also serves as a search bar. You can type in keywords and the system will return a list of matching pages and assets.

My Pages

The My Pages button ![star](image) displays a list of pages you have bookmarked in Percussion. The My Pages button is located in the upper left hand corner, directly below the main menu and to the left of the search bar. This tool provides you a
way to rapidly access pages you are actively working on or which you frequently edit. You can add and remove pages to My Pages from the Editor view.

Opening Finder Elements

From the Finder, you can open sites, pages, and assets for editing. You can also open pages in read-only mode.

- To open a page in read-only mode, double click on it. It opens in Editor View, but cannot be edited.
- To open a page for editing, open it in read-only mode and then click the [Edit] button.
- To open an asset in read-only mode, double click on it. It opens in Editor View, but cannot be edited.
- To open an asset for editing, open it in read-only mode and then click the [Edit] button.
- To open a folder for edit, highlight the folder in the Finder, then click on and select “Folder Properties” to open a dialog for editing its properties.

Expanding and Collapsing the Finder

Clicking the Collapse button reduces the Finder so that only the navigation bar and action buttons across the top are visible:

Collapsing the Finder is useful because it expands the size of the lower panel so that you have more room to work in the Editor or one of the Admin views. Once the Finder is collapsed, clicking the Expand button (the same button) expands the Finder and reduces the lower portion of the screen.

Assets and Sites in the Finder

In the Finder, folder paths holding Assets and Sites are formatted similarly and have many identical components. Some of the components are labeled in the graphic of the Finder at the top of this page, and we have already discussed them. In this section, we will look at what is different about the way the Finder displays assets and sites.

Sites

When you click Site, the Finder displays each site in your system. You can expand a site to see its sections and folders and the pages contained within each section or folder.

Configuration button - Allows you to view folder Properties, such as the name of a page.

Preview Button - Opens a preview of the selected page.

Folder - The icon represents a regular folder. You create folders to store or categorize pages, assets and other folders. To rename a folder, double click on it. Its name becomes editable in the Finder.

Section Folder - The icon represents a section folder. A section folder, which represents a section of the website, appears in the Finder when an Admin creates a section of a website. When you click a new section folder in the Finder, the landing page appears in the next column.

Home Page or Landing Page - The icon represents a site's home page or a section's landing page. The home page is the page that first opens when you enter a site's URL in a browser. A landing page is the page accessed when you click a section link in a live website. The system creates a home page when an Admin creates a site and creates a landing page when an Admin adds a new section. When you select a new site, the home page always appears in the next column. Likewise, when you select a new section, the landing page always appears in the next column.
Page - The icon represents a page of a website.

Page properties - When you select any type of page (a page, a landing page, or a home page), the next column opens and shows the page's properties. The Finder displays the same properties for each type of page:

- **Page Link** - Name used to represent the page in any system-generated links. When you click on the text, Percussion CM1 displays a preview of the page either in a new tab or a new browser window.
- **Template** - The name of the page's template.
- **Status** - The state in the page's life cycle.
- **Last Modified** - The last user that modified the page and the date and time on the CM1 server that their modifications were saved.
- **Last Published** - The page's last publish date. If the page has not yet been published, the Last Published property is not shown.

Editor View

The Editor View is used to create or edit items in the Finder. To access Editor view to edit items, double-click on an asset or page in the Finder. The item opens in its form or editor in Editor view. You can also access Editor View from the menu located in the upper left hand corner of the interface.

Bookmarking pages

When viewing pages in Editor view, you have the ability to bookmark pages by adding them to "My Pages". To do this, click on the star icon to the far right of the Content, Layout, and Style tabs. You can remove a bookmark by clicking the star on any page that has been bookmarked. Any page that has been "starred" will appear in My Pages in the Finder.

Working with Pages in Editor view

Editor view displays pages and assets differently. This topic discusses how pages are displayed in Editor View. When you first open a page, Editor view displays it in the Content tab in read-only mode, as in the following graphic.
The page has three tabs, Content, Layout, and Style, but the Layout and Style tabs are disabled. The buttons [Close] and [Edit] appear in the upper right corner. You can click [Close] to close the page or [Edit] to open the page for editing.

To edit the page, click the [Edit] button. Now, the page appears in edit mode. If you have the required permission, the Content, Layout, and Style tabs are all visible. Links to other pages in the content are enabled, and edit markers and controls are visible. The button [Close] and a few workflow buttons appear in the upper right corner. You can click [Close] to close the page and save any edits you have made.

**Content Tab**

When you are in edit mode on the Content tab, you can add content and edit content in widgets that are located on the page. You can also delete widgets from the page. When you click a widget, an edit button and a delete button appear in the upper right corner of the widget. If you have permission to edit and delete this widget, the buttons are enabled, as in the following graphic. If the widget is not editable, or if you do not have access to either of these functions, the button for the function is grayed out. If the widget’s content was added in the template, a lock icon appears on the widget instead of the edit and delete buttons. Note that if the content in the widget is an asset, the editor indicates this to you by showing an edit button that appears as instead of .

In the upper left corner of the tab are Actions, View, and Publishing links. These links will vary based upon your user permissions.

When you are in read-only mode, you can view the meta-data information. When you are in edit mode, you can edit the meta-data information. Click the Meta-data link to open a dialog that allows you to view or change the page’s meta-data.

To view past versions of a particular page click on revisions under the view menu to open a list of revisions for the page.

When a page is opened in edit mode, you see region outlines and markers for unfilled widgets, and links are disabled. Links are also disabled when you see a page in read-only mode. Click Preview in either mode to see how the content that you have added will appear on a page and to access functioning links.
Working With Pages

Editing Content through a Widget Editor

Widgets allow you to perform a variety of tasks through the system, including adding content, without having to write any code. As a User Level 2, you will most commonly be using the Rich Text Editor widget and Collapsible Box widget.

To add content through a widget editor:

1. Click the edit button on the widget. The widget editor opens. There are many different types of Widgets, and some of them have different content fields.
   - On a page, a widget can contain content and have a lock icon on it. The lock icon indicates that the page inherited the widget and its content from the template. The content cannot be edited on the page.
   - If you do not have permission to edit a widget, a dialog pops up and warns you when you attempt to edit it.

2. Enter content in the content fields.
3. Click [Save].
   If any of the data you have entered is invalid, a message describing the cause of the error appears on the dialog, and you must correct the error before you can save the content.

Modifying Content Through a Widget Editor

You can edit a widget's content through its widget editor if it displays an enabled or icon. The icon indicates that the widget contains local content. The icon indicates that the widget contains an asset (shared content).

The following graphic shows the editor for a widget containing local content:
Quick Facts:
- A Rich Text Editor Widget must be used to add content to a page.
- To remove a widget from a page completely, you will need to be on the layout tab.
- If a widget has a lock icon on it, it is unavailable for edit. The lock indicates that the widget has inherited content from the associated template.
- If a widget has a disabled pencil icon, you cannot edit it. The disabled pencil icon indicates that the widget cannot contain user-added content.
- If a widget is in a workflow state that you do not have access to, when you attempt to edit it, a dialog warns you that you do not have edit permission.

Previewing a Page

Previewing a page allows you to see the page as it will look when published. Previews show the most recently saved changes to a page. If you are editing a page and have not yet saved your changes, they will not be included in the preview. Or, click on the icon located on the upper right corner of the finder.

If you make changes to the page, you do not have to close and re-open the preview window/tab. Instead, just click the browser refresh button to reload the page with the new changes. Any links in the preview page open similar previews of the target page of the link.

You can preview a page from the Finder or from the Editor.

Previewing a Page from the Finder

Any user can preview a page from the Finder. To preview a page from the Finder, select the page, then click on the Page Link value in the page properties.
Previewing a page from the Editor

To preview a page from the Editor, you must have edit rights to the page. If you do not have edit rights to the page, use the Finder to preview the page.

To preview a page from the Editor:

1. In the Finder, double-click on the page to open it.
   - Percussion displays the page in the content viewer.
2. Click on the Content tab. This is the default tab when you first open a page for edit.
3. In the content viewer toolbar, hover your cursor over View and click the Preview link

Viewing and Editing Page Meta-data

As a CM1 user you can add meta-data to your pages which CM1 uses in multiple ways. As of 2.6, the meta-data is stored in expandable and collapsible groups of information including Page Summary, Search Engine Optimization (SEO), Tags and Categories, Calendar, and Additional Code. Certain fields are even auto-filled based on other metadata fields e.g. the required Page title field under the SEO grouping is auto-filled based on the Display title.

Viewing page meta-data:

1. To view meta-data, open the page in read only view (Double click on the page in the Finder).
2. Click the Meta-data link.
3. If the page is in read-only mode, the meta-data will be displayed in read-only mode.

Editing page meta-data:

1. To edit meta-data, open the page in edit mode.
2. Click the Meta-data link and edit the fields.
   - Note: There are some fields which will still be in read-only mode.

Page Summary File Name - Character validation

Characters that are not valid in file names on Microsoft Windows operating systems:

\ / : * ? " < > |

Characters that are not safe in URLs:

- # (hash, pound, or octothorpe; used in HTML anchors)
- ; (semicolon; used to append JSession IDs to URLs)
- % (percent sign; used to encode or escape characters in URLs)

How To Add Collapsible/Expandable Boxes

1. Navigate to the page within the Finder that you would like to add a collapsible/expandable box to. Once the page has been located, double click on it to open the page in “Read Only” view. Click on the blue EDIT button to enter into Editor View

2. Click on the Layout Tab
3. Click on "Add Widget" and then select "View All"

4. Scroll through the widgets list until you locate the "CollapsibleBox"

5. Click and drag the "CollapsibleBox" icon onto the layout editor screen until you see a green highlighted area like this:

6. Repeat steps #3-5 for each individual collapsible/expandable that you'd like to add.

7. After your "CollapsibleBox" Widgets have been placed, click [SAVE] in the upper right hand corner to submit your edits.

8. Go back to the "Content" tab and click on the blue button on the "CollapsibleBox" widgets that you just placed to open it for editing.
9. In the screen that appears, there are three fields:

**Title** – Enter in the heading of the collapsible box here. This is the text that will always be visible and will be what is clicked upon to expand or collapse the box.

**Body Copy** – Use the rich text editor to enter the content for the collapsible box in this field. This is the information that will be viewed or hidden when the Title text above is clicked on.

**Opened by Default?** - Enter “yes” into this field if you wish to have the Body copy displayed by default, or enter “no” if you want it to be hidden, and only displayed upon clicking on the title text.

10. Click [SAVE] when completed and move on to the next collapsible box if needed.

**Workflow Comments**

Users have the ability to enter comments as they are submitting items through the workflow. The objective of workflow comments is to make it easier for subsequent users to understand what was changed or to provide directive to those users. Used in coordination with revision history, it can be a valuable tool to assist in audits related to content changes.

For each workflow action you will be prompted to enter a comment. Comments are not required, but can be helpful to users in the next step of the workflow.
For example, if a user is editing a page it will be helpful to inform the approver what changed. Similarly, if an approver is rejecting a page that was submitted, it would be helpful to explain to the author why content was rejected.

If a user enters a comment, a comment icon will appear next to the action buttons at the next step of the workflow. You can hover over the icon to see the comment.

**Viewing Comment History**

To view a history of workflow comments select View > Comments in the menu directly below the Content, Layout & Style tabs as seen to the left.

For each comment entered, you will be able to see who entered it, when, and at what step of the workflow as seen in the following graphic:

**Working with Page Revisions**

A revision is a copy of a page that CM1 creates when you edit it.

You can view all of the revisions of a page when the current revision is open. You can also restore an older revision of the page, making it the current revision.

*Note: A page must move to Approved status before CM1 begins creating revisions.*
To view page revisions:

1. Open the page in editor view in either read-only mode or edit mode.

2. In the upper left corner of the page, hover your cursor over View and click the Revisions link.

3. CM1 opens a dialog listing each revision of the page. By default, revisions are sorted from highest to lowest, but you can sort the list on any column except Actions. The maximum number of revisions listed per page is 10; this is not a configurable setting. The Actions column displays Latest for the current page, preview and restore for all other pages.

4. Select the revision you want to preview. CM1 opens the revision page in a separate window or tab, depending on your browser configuration.

5. Close the revision page to return to the list of revisions.

6. Either view another revision or click [Close] to close the revisions dialog and return to CM1’s Editor view.

To restore a page revision:

1. Follow the steps for viewing revisions to open the list of revisions in either read-only or edit mode.

2. Click the restore revision icon in the row of the revision that you want to restore. A popup informs you if you do not have permission to restore the page. Otherwise, the revision becomes the current version of the page opened in edit mode and the list of revisions dialog closes.
Approvals and Pages by Status

If you have a User Level 1 in your department, you will need to use this tool frequently to approve and publish changes. You may also want to use this tool to view what Users in your department are working on. This will help you maintain your section of the website.

Add a "Pages by Status" gadget to your dashboard by dragging it from the “Add Dashboard Gadgets” tool. Once in the Pages by Status gadget, select the section that you manage. (For example: School of Nursing) This will allow you to view all activity on the SON pages.

When looking at item (page) details in the Finder, you will see entries by Status: (see photo above)

**Pending:** The item has been approved but has not yet been published, the item has a scheduled publish date, or publishing may have failed for the item.

**Live:** The item has been published to the site and is live.

**Quick Edit:** The item has been opened for edit. The most recent published revision will be republished during a full publish, or published on demand.

Items with these status entries are in an Approved status; meaning users with publishing rights have made changes.

The below statuses are entries that have not been approved, meaning that users without publishing right have made changes.
**Draft:** This indicates that a user without publishing rights has submitted the page, they may be editing it currently, or submitting for approval may have failed for the item. (If you are unsure of the status, you will need to communicate with the user directly)

**Review:** The item has been submitted for approval by a user who does not have publishing rights. Action is required with this status.

### Approving/Rejecting

If you have been tasked with approving User Level 1s work, you will need to follow the following steps. To approve/reject an item that is in the “review” status you:

1. Open the page for editing by clicking on the page in the status queue as seen below:

   ![Pages by Status](image1)

2. Once opened for editing, you can view the comments for the changes submitted by clicking on the “view” menu and selecting “Comments from the list” as follows:

   ![Comment View](image2)
3. If approved - click on “approve” and enter comments if desired, then click approve again as illustrated below:

![Image of approving page](image)

4. NOTE: Although the item is approved, you will still need to publish the page (which makes it live). See the publishing a page section below to see how to do this.

5. To reject a page, follow the same steps, but click on “reject” (instead of approve) and enter comments if desired, then click reject again as seen below:

![Image of rejecting page](image)

The second way you can approve pages, which is helpful in instances where you have already seen the changes (e.g., You share an office with the user) is directly through the Pages by Status Gadget on your dashboard:

1. Check the box to the left of the item in review, click the “Approve button at the top of the Pages by Status gadget.
2. Again, this will not publish the page, you will still need to follow those steps to make the page live.

![Image of Pages by Status gadget](image)
Working With Assets (Files & Documents)

Images, files and documents are referred to as “assets” in Percussion. There are multiple ways to upload, edit and publish your assets, as well as important permissions information included in this section.

Permissions

If you need a new image or graphic added, send it to your department Super User (SU) or UCM Account Manager. If the image or graphic complies with Oakland University’s brand guidelines, they will upload the image or graphic for you. Once it’s uploaded, you’ll have full access to use, edit and implement the image or graphic. **UL2’s do have full access to upload files and documents.**

Important Notes

- All new images and graphics are located here: /Assets/Oakland/(your section)/graphics
- All new files and documents are located here: /Assets/Oakland/(your section)/files-and-documents
- If you need to access an asset that was uploaded into the old CMS, it will be located here for images: /Assets/upload/images/(your section) and here for documents: /Assets/upload/docs/(your section).
- Assets **must** be published. Uploading an asset alone will not make it available to use on the live (published) page. Publishing your assets is a separate process (covered below). As a UL2, you are able to publish existing assets if you make edits to them or they aren’t already published.
- Publishing a page which contains a newly uploaded asset will only publish the page, **not** the asset. The asset must also be published. Publishing your assets is a separate process (covered below).
- If your asset does not work on the live page, but it does work in edit or preview mode, this means your asset is not published.
- When you’re editing a page, some widgets offer an “Upload” asset button. Do **not** use this method for uploading assets. It will save your asset in a large unorganized communal folder. To avoid using this upload button, you should always be sure your assets are uploaded before you edit your page.

Uploading Assets (Files and Documents)

1. In this example we’ll use the UCM section. Navigate to your assets folder by either typing your path into the search bar, or by single-clicking the folder path in the columns under the search bar. The path in this example is  /Assets/Oakland/ucm/files-and-documents (shown below).

![assets folder](image)

2. It’s best practice to keep your assets as organized as possible. If you’d like to create a new folder within your “files-and-documents” folder, first single-click on the “files-and-documents” folder. When the “files-and-documents” folder is highlighted, click on the “create new folder” icon in the icon section to the right of the search bar. Then type in the name of your new folder and click enter.
3. Click on the folder you want to upload your file into; whether it be “files-and-documents” or the new folder you just created. With your folder highlighted, click the “create new asset” icon in the icon section to the right of the search bar.

4. The “New Asset” window will open (shown below). Click the right arrow until you see “files-and-documents.” Click “files-and-documents,” and then with it highlighted click “NEXT.”

![New Asset Window]

5. Click the “Choose File” button and navigate to the image on your computer.

6. In the “Link text” area above it, you must name your file or document.

7. Hit “SAVE” to upload it. If you hit “SAVE,” then you’ve now uploaded your file or document, but it still needs to be published. Continue to Step 9 to publish.

8. After you hit “SAVE,” you’ll notice there’s now a “Publishing” dropdown menu on the left side of the same bar that contains the “SAVE” button. Go to the “Publishing” dropdown menu. When it opens, click “Publish.” (shown below). You may also choose to hit the submit button to the right. This will give you the opportunity to add a note about what you’re uploading and give others the opportunity to see it before you publish it.

![Publishing Menu]

9. Once you’ve hit “Publish,” your file or document is ready to use.

**Publishing Assets**

1. If you need to publish an asset previously uploaded at an earlier time, you first need to navigate to the asset in the percussion finder. Navigate to your assets by either typing the path into the search bar, or by single-clicking the folder path in the columns under the search bar. The path in this example is /Assets/Oakland/ucm/files-and-documents/Contact list updated 10_29_14.pdf (shown below).
2. After you've navigated to your asset, double-click it to open it. The asset information will open in the window below, then click the “EDIT” button on the right side of the center bar (shown below).

3. After you hit “EDIT,” you'll notice there's now a "Publishing" dropdown menu on the left side of the same bar that contains the “SAVE” button. Go to the “Publishing” dropdown menu. When it opens, click “Publish.” (See image below). You may also choose to hit the submit button to the right. This will give you the opportunity to add a note about what you’re uploading and give others the opportunity to see it before you publish it.

**Bulk Uploading Assets**

1. If you’re uploading multiple assets at the same time, you can choose to do a bulk upload. If you haven’t read the sections in this manual about using The Dashboard and Managing Dashboard Gadgets, please do so before
continuing this process. The first step is to go to the Percussion Dashboard and drag the “Bulk Upload” gadget to your dashboard.

2. In the “Target folder” section, navigate to the folder you want the assets to upload into. You must upload your assets to Assets/Oakland/(your section)/files-and-documents. If you’d like to create a new folder to organize your uploads, you may, as long as the new folder is inside your sections “files-and-documents” folder. Creating a new folder must be done before you start this process. To learn how to create a new folder, see step 2 in the “Uploading Assets” lesson.

3. Once you select a folder, the “Approve assets” checkbox will become available. Click the checkbox. We do need to approve the assets.

4. In the “Asset type” drop down menu, select “File.”

5. Click “ADD FILE” and navigate to the assets on your computer; select as many as you want.

6. To double check your selected uploads, or to watch their upload progress, hit the “+ Details” button.

7. Click “UPLOAD.” You’ve now bulk uploaded your assets, however they still need to be published. To learn how to publish your assets, see the “Publishing Assets” section of this document. If you have an unmanageable quantity of uploads to publish and would like assistance, you can email UCMHelp@oakland.edu. State you’ve performed a bulk upload, tell us which folder you put them in, and request an “Incremental Publish.”

Deleting Assets

Contact ucmhelp@oakland.edu or your UCM Account Manager to assist you in deleting assets.

Putting an Asset Onto Your Page

Files & Documents:

1. Before you can place a document or file onto your page, you first must upload and publish it. Once your file is ready, and you’ve begun editing the page you’re working on, you can now link to the file.

2. When you’re ready to link to your file or document, highlight the text, image or clickable content that you’d like to link your document to. Once it’s highlighted, click on the link icon to the right side of the toolbar, or you can click “Insert link” in the “Insert” drop down menu.

3. Now the “Insert link” menu will open. Click on the folder icon to the right of the “Url” bar. After you click the folder you will be on the “Select a page, file, or an image” window. Here you’ll click the folder path to navigate to where you previously uploaded your document to. Click /Assets/Oakland/(your section)/files-and-documents/(your document name). Once you’ve clicked the name of your document, it’s highlight, click the “OK” button.

4. Percussion will fill in a title for you, but you can change it if you want to. The “Target” drop down menu will let you select either “None” or “New window”. If you select “None,” the file or document will open up in the same browser tab the user is viewing your page on. If you select “New window,” the file or document will open up in a new tab. Click “OK” when you’re ready to insert your file. Then click “SAVE” to save your changes and insert the file onto your page.

21
5. Now that you've added your file or document, you need to publish the page before it will show up on the live site. To publish the page, click the "Publish" button in the "Publishing" drop down menu (shown below). You may also choose to hit the submit button to the right. This will give you the opportunity to add a note about what you’re uploading and give others the opportunity to see it before you publish it.

Non-Rotating Banners:

NOTE: If you need a new image or graphic uploaded for the banner, please contact your UCM Account Manager or ucmhelp@oakland.edu. If the banner complies with Oakland University's brand guidelines, they will upload the image or graphic for you. Once they are uploaded, you’ll have full access to use, edit and implement them.

1. Once your image is uploaded and published by an admin., navigate to the page you’re placing the banner onto and open the page for editing.
2. If there is already a banner in place that you’re replacing, you’ll first need to remove the current image. To do so, click on the image while you’re editing the page, then click the “x” that appears in the top right corner of the image (shown below). You’ll be asked to confirm you want to remove the image; click “YES.” The space where the image was will now be grey with a message saying “This image is empty.”

3. Once your page is open for editing, and the banner widget doesn’t have an image in it, it’s time to navigate to your new banner in the navigation columns above. Your banner should be located in /Assets/Oakland/(your section)/graphics/(your non-rotating banners folder name). In this example, the banner is located here: /Assets/Oakland/ucm/graphics/Subsite-Banners.

4. Adding the image is a simple drag-and-drop. In the column view, click on your banner image and drag it down below onto the empty widget on your page. The banner widget is labeled with “This image is empty.” When you have your image dragged over the widget, the widget will highlight. If the right widget is highlighted, release the mouse button to drop the image there (shown below).
5. Once your image is in place, you must publish the page for it to be on the live site.

**Rotating Banners:**

**NOTE:** If you need a new rotating banner image uploaded, please contact your UCM Account Manager or ucmhelp@oakland.edu. If the banner complies with Oakland University's brand guidelines, they will upload it for you. Once they are uploaded, you’ll have full access to edit them.

**Forms**

There are three types of forms commonly used on OU web pages. These forms are all created outside of Percussion. The three types of forms are:

- **PerfectForm** - This form should be used when asking for sensitive information (e.g. SS#, personal address, medical information and G-number). If you have a file to attach to your form, use PerfectForm. Contact uts@oakland.edu to get started.
- **MarketPlace** - This form should be used when a credit card transaction is required. Contact mkplace@oakland.edu to create this type of form.
- **Google Form** - This form should be used for simple forms (e.g. RSVP’s or Request More Information forms). Human Resources offers training on how to set up a Google form which can be found here https://wwwp.oakland.edu/uhr/professional-development-training/current-training-offered/.

**News and Events**

**News**

All news articles must follow journalistic principles and include the five Ws: Who, What, Where, When and Why. All articles posted to any web section’s “news” folder will funnel up into the News at OU.

News articles must be submitted through this [online form](https://wwwp.oakland.edu/uhr/professional-development-training/current-training-offered/) or through your UCM account manager for UCM’s media relations department to consider. If media relations produces the story, they will handle posting to your web section, News at OU and possible home page placement as well as external media outreach and OU social media.
Events
An event calendar listing should be created for every public facing event. All articles posted to any web section’s ‘events’ folder will funnel up into the OU Events Calendar. All calendar items must come through the online form and are processed within 3 business days. Bulk requests may take longer.

Event listings can be edited by any user with permissions to the web section that the event resides in.

- If edits are being made to the event name, description, location, contact, or categories, simply make those changes in the widget on the event page and Approve the page. Do not click Publish or it will override the schedule to remove the event once it’s taken place.
- If edits are being made to the event date or time, you will need to:
  - Update that information in the Start Date & Time selector in the event widget and save out of the widget
  - Click on Edit > Meta Data and then update the File Name, Display Title and Page title (browser title) found in the Search Engine Optimization dropdown and save out of the meta data.
  - Click on Publishing > Schedule and select the new end date/time for the time. Choose a time in the near future for Publish Date. Choose the end date/time Removal Date. Save out of the schedule.